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Safety Precautions 
This manual explains the precautions in the order of warning, caution, and importance in order to ensure that the product is used correctly 

and to prevent harm to the user and those around him, damage to property, etc. 

Before using the product, please familiarize yourself with the contents of the precautions. 

 

ＷＡＲＮＩＮＧ 
If this indication is ignored and mishandled, it  

indicates that a person may be killed or seriously injured.  

CAUTIONS 
If this indication is ignored and mishandled, it indicates that it is likely that a person 

may be injured or that only property damage will occur. 

IMPORTANT In addition, it shows important information for using this product. 

 

ＷＡＲＮＩＮＧ 

* About installation 

Do not install this product in places with high humidity or in places where it gets wet with water. 

If water is spilled inside, it may cause an irreparable malfunction. 

* Usage environment 

The upper limit of the ambient temperature (maximum rated ambient temperature) when using this product is  

30 [°C]. 

Be careful not to exceed this maximum rated ambient temperature. 

* Regarding insertion and removal of cables, do not plug or unplug  

the USB cable or the cable for connecting to the target system while the power of the EFP-LC2 main unit and 

the target system is on. 

 

CAUTIONS 

* Do not disassemble or modify this product. Failure to do so may result in a malfunction. 

* Handle this product carefully and do not subject it to strong impact due to dropping, falling, etc. 

* Do not touch the metal terminals of each connector directly with your hands. 

* Do not use this product in an upright position. 

* If you do not use it for a long time, put it in a plastic bag to keep the moisture down. 

Store in a place with a temperature of 0 to 37[°C] away from direct sunlight. 
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Please read this first 
Thank you very much for purchasing the EFP-LC2, a lightweight and compact stand-alone serial programmer. 

 

⚫ Please be sure to read the instruction manual carefully before using it. 

⚫ If you have any questions about the product, please contact us or your distributor. 

⚫ The EFP-LC2 manual consists of the following manuals:  

Please be sure to read the respective manuals before use.  

A) EFP-LC2 Manual: This document. EFP-LC2 hardware specifications, EFP operation applications 

B) Additional Manual: Connection information for each microcomputer family, available commands. 

C) Diff Manual:  A) or B) Additional microcomputer difference information after issuance, etc. 

D) Communication Protocol Specification: Communication protocol specification for the Windows virtual COM port with the EFP-

LC2 main unit *1 

The contents of this manual are subject to change without notice.  

The latest information can be viewed on our website (https://www.suisei.co.jp).  

*1 By using communication commands, you can operate the system from your application. 

If you would like the EFP-LC2 communication protocol specification, please contact us via the inquiry page (suisei-

support.x2@suisei.co.jp). 

 

⚫  The warranty period of this device is one year from the date of purchase. During this time, defects caused by manufacturing 

problems will be repaired free of charge.  

Contact your distributor or us.  

However, in the following cases, you will be charged even within the warranty period.  

A) Defective consumables such as sockets and switches 

B) Fires, earthquakes, acts by third parties, and other accidents or natural disaster 

C) Intentional, negligent, misuse, or use under abnormal conditions by the customer 

D) Modification and repair of EFP-LC2 and accessories by the customer 

 

⚫ We cannot guarantee defects in the MCU device written by this device or problems caused by it. 

 

⚫ While we have carefully considered and taken measures to ensure safe use, we cannot fully anticipate all potential hazards and 

misuse. 

⚫  When using this equipment for mass production, please consider the usage environment and other factors by yourself in advance 

and check the reliability before using it. The warnings in this manual are not exhaustive, so it is your responsibility to understand and 

judge them and use them correctly and safely.  

 

⚫ When used in Japan, it is not subject to Electrical Appliances and Materials Safety Act or electromagnetic wave interference 

countermeasures.  

In addition, this device does not have safety standards such as UL or IEC standards.  

Therefore, please note this point when taking it out of Japan overseas.  

 

⚫ The contents of this manual are subject to change without notice in the future due to performance improvements or other reasons. 

Please note that we are not responsible for the results of the operation of the described contents. 

 

⚫ This document and its products are protected by copyright and industrial property rights, and all rights belong to the Company.  

Parts of this document may not be copied, reproduced, or reprinted without the prior written consent of the Company.  

 

⚫ When disposing of this equipment, be sure to dispose of it as industrial waste in accordance with laws and regulations. 

 

⚫ For inquiries regarding this manual and the contents of the software, please contact us by E-mail or the following inquiry page. 

 

Inquiries 

SUISEI Electronics System Co., Ltd. 

6-5-24 Tsurumi, Tsurumi-ku, Osaka, 538-0053, Japan 

E-mail: suisei-support.x2@suisei.co.jp 

Contact page:  https://www.suisei.co.jp/contact/ 

  

https://www.suisei.co.jp/
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1. Product Details 
The EFP-LC2 is a lightweight and compact stand-alone serial programmer that performs operations such as erasing and writing to 

Renesas Electronics microcomputers on the target system.  

It is used in conjunction with the control software LC2-Download Manager.  

 

<Features of LC2-Download Manager> 

⚫ Download/upload/command execution function to EFP-LC2 

⚫ Security setting function for EFP-LC2 

⚫ Simplified command creation function (PBT file) for EFP-LC2 

 

 

1.1 Packaging Contents 
This product consists of the following boards and components. When you open the package, make sure you have everything. 

Table 1.1shows the list of packing contents. 

 

Table 1.1 EFP-LC2 Packaging Contents List 

name explanation Number 

EFP-LC2 Serial programmer 1 unit 

EF1TGCB-16WX Connection cable between EFP-LC2 and target system (loose wire) 1piece 

Attachments EFP-LC2 Product Description 1piece 

* A USB cable (Type-C) for connection to the host machine is not included. Please prepare a commercially available product. 

 

 

1.2 Terminology 
The terms used in this document are defined and used as follows:  

 

⚫ Main unit:  Refers to EFP-LC2.  

⚫ Host Machine:  Refers to a personal computer for controlling control software. 

⚫ Control Software: Refers to LC2-Download Manager. 

The settings in this software may be abbreviated as GUI (Graphical User Interface).  

⚫ Target MCUs:  Refers to a microcomputer operated via EFP-LC2. It may be referred to as MCU. 

⚫ Target System:  It refers to the customer's application system in which the target microcomputer is implemented.  

⚫ User Programs:  It refers to the customer's application program that writes to the target microcomputer. 
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1.3 Specification 
 

Table 1.2 EFP-LC2 Product Specifications 

item Contents 

Programmer 

Specifications 

Write method Renesas Electronics MCU Programming Mode (Boot Mode) 

Writing target*1*2 RX Family 

RA Family (planned) 

RL78 Family 

R8C Family (planned)*3 

Memory Region Space for program files (up to 4MByte) x 6 Area 

Area for the [Read] command (up to 4MByte) x 1 Area 

PBT file area (up to 64KByte) x 1 Area 

Log Files (RESULT.TXT) (up to 1.212MByte) x 1 Area 

interface 

(Target system side) 

Dual in-line connectors (2x8) 

* Reference Table 1.6 

interface 

(Host machine side) 

Virtual COM port (USB Type-C connector) 

Host Machine 

Specifications 

OS*4 Windows11*5 

processor Meet the requirements of Windows 11 

memory 

storage 

power EFP-LC2 Powered by USB bus power 

Target System Within the range of 3.3[V] to 5.0[V] and the operating power supply 

voltage range of the target microcomputer 

Standby current When supplied from the target system (+3.3[V]): 

When supplied by the target system (+5.0[V]): 

When supplied via USB bus power: 

100[mA] 

80[mA] 

80[mA] 

Environmental conditions during use 10[°C] to +30[°C]  (No condensation) 

Environmental conditions during storage 0[°C] to +37[°C ] (No condensation) 

External dimensions 85 (W) x 47 (D) x 15 (H) [mm] (excluding protrusions) 

weight 40[g] 

*1 Please check our website for the latest device list. 

*2 To support new devices, you may need to update the control software (Reference 4.1.3(1) Section) or firmware (Reference 4.9 Section). 

*3 Excluding R8C/10 to R8C/1B 

*4 Microsoft .NET Framework 4.7.2 or later is required. Normally installed during installation. 

*5 Windows 11 is a trademark or registered trademark of Microsoft Corporation in the United States and other countries. 

 

  



EFP-LC2 User's Manual  
 

Rev.1.04 2026/04 Page 7 / 41 

    

 

1.3.1 Program File Format 

The following program files are supported by EFP-LC2. Unsupported files will result in an error. 

 

I. Intel Hex Format (extension: hex) 

⚫ The file ends at the end record 

⚫ There are no rows other than 00 - 05  type records 

 

II. Motorola S format (extension: mot) 

⚫ The file ends with an end record (S7, S8, S9). 

⚫ There are no lines other than S0-S9 (excluding S4) 

 

III. Suisei Electronics System HXW format (extension: hxw) 

⚫ HXW format generated by RC-Downloader or LC2-Download Manager manufactured by SUISEI Electronics System 

 

1.3.2 Project file (extension: prj) 

A project file is a file that contains the information required by LC2-Download Manager. 

This file stores information such as target microcomputer, program file, PBT file, etc. 

 

1.3.3 PBT file (extension: pbt) 

A PBT file is a script file that controls the target microcomputer for erasing, writing, etc. 

[Quick Creation] (Reference 4.3 Section) can be created by selecting the function you want to control. In addition, PBT files created 

for our products such as EFP-LC can be used (except for some commands). 

 

IMPORTANT 

* Do not edit the project file with an editor. 

* Do not edit the setting file with an editor. 

* If you edit a PBT file generated with [Quick Creation] using a text editor, etc., an error will occur when the control software 

loads it. 

In this case, the setting information in [Quick Creation] will be invalid, but you can register it with the [Reference] button. 

* If a file name contains characters that cannot be used, an error will occur. 
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1.4 System configuration 
1.4.1 Connect the EFP-LC2 to the target system 

When erasing, writing, etc. operations on the target system,Figure 1.1Connect the EFP-LC2 to the target system with the supplied 

cable as shown below. The connection between the EFP-LC2 and the target system is It is recommended that the cable length be 

within 500 [mm]. 

 

 

 
 

Figure 1.1 Connecting to the target system 

 

 

1.4.2 Connect the EFP-LC2 to the host machine 

When downloading/uploading from the control software LC2-Download Manager,Figure 1.2 Connect the EFP-LC2 to the host 

machine with a USB cable as described below. 

When using the EFP-LC2 standalone to write to a target microcomputer, there is no need to connect the host machine to the target system. 

 

 

 
 

Figure 1.2 Connecting to the host machine  
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1.4.3 Powering the target system 

The power supply to the target microcomputer is connected to the target system (Reference 1.4.3.1 Section) or EFP-LC2 (Reference 

1.4.3.2 Section). 

For details on how to connect to the target system, refer to the separate instruction manual for each microcomputer family. 

 

1.4.3.1 Supplying power from the target system to the target microcomputer 

When supplying power from the target system to the target microcomputer, the [VDD supply] command is not required.  

In addition, it is possible to run PBT without a host machine connection (standalone).  

 

ＷＡＲＮＩＮＧ 

* Regarding insertion and removal of cables 

Do not reconnect or unplug the USB cable or the cable used to connect to the target system while the target system is powered on. 

* Connecting the EFP-LC2 to the host machine while the power supply to the target system may cause a malfunction 

If you want to connect to the target system, follow the steps below. 

I. Connect the EFP-LC2 to the target system with the target system connection cable 

II. Connect the EFP-LC2 to the host machine with a USB cable 

III. Externally powered 

 

 

 

1.4.3.2 EFP-LC2 to power the target system 

It can be supplied from the host machine to the target system*1 via EFP-LC2.  

*1 Supplied from the connector (CN5-4: T_VDD) for connecting to the target system with the [VDD supply] command.  

 

ＷＡＲＮＩＮＧ 

* Regarding insertion and removal of cables 

Do not disconnect or unplug the USB cable or the cable used to connect to the target system while the power of the EFP-LC2 unit is on. 

* When using this command, do not supply power from the target system to the target microcomputer.  

When the power supply voltage (T_VDD pin) on the target system side is detected to be +2 [V] or more when using this command, the 

EFP-LC2 does not supply power (output) to prevent power collisions.  
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1.5 LED Specifications 
 

Table 1.3 EFP-LC2 LED Specification(Other than VCC LED) 

State Condition 

LED status 

STATUS 

(Green) 

RUN 

(Yellow) 

ERR 

(Red) 

File Operations 
PBT file/program file not downloaded Lighting Lights out Lights out 

PBT File & Program File Download Flashing(250ms) Lights out Lights out 

Waiting for PBT file execution - Flashing(250ms) Lights out Lights out 

PBT file execution in progress 

PBT file running Lighting Lighting Lights out 

Device error occurred *1 Flashing(250ms) Lighting Lighting 

File access error occurred *1 Lighting Lighting Flashing(125ms) 

Other error occurred *1 Lighting Lighting Lighting 

Wait for input on the [Wait] command Flashing(250ms) Lighting Lights out 

PBT file execution complete 

Completed successfully 
Two LEDs flashing alternately 

(250ms) 
Lights out 

Completed with error *1 
Two LEDs flashing alternately 

(250ms) 
Lighting 

Secure Settings (Level2) 

When the specified number of times 

execution is completed 

Internal data deletion (excluding logs) 

PBT execution complete & before internal data erasure 
Two LEDs flashing alternately 

(250ms) 
Lights out 

Wait for internal data erasure to begin Flashing(100ms) Lighting Lights out 

Erasing internal data Lights out Flashing(100ms) Lights out 

Internal data erase complete 
Two LEDs flashing alternately 

(250ms) 
Lights out 

Setting/Canceling the Secure 

Function 
Secure function setting error occurred Flashing(250ms) Lights out Flashing(100ms) 

Firmware update in progress 

(Reference section 4.9) 
- Flashing(250ms) Flashing(100ms) Lights out 

EFP-LC2 internal data initialization 

(Reference section 5) 

With the [START] switch ON, turn the power ON Lighting Lighting Lights out 

Waiting to start initialization Flashing(100ms) Lighting Lights out 

Initializing Lights out Flashing(100ms) Lights out 

Initialization completed Lighting Lights out Lights out 

*1 If an error occurs during PBT execution, the error status will be displayed on the LED immediately after the command is executed. Then, 

once PBT execution is complete, the LED display will switch to indicate PBT execution complete (error termination). 

 

*For details on the LED display when an error occurs, see Chapter 6. 

*The RUN (yellow) LED will light up while communicating with LC2-Download Manager. 

 

Table 1.4 EFP-LC2 LED specifications (VCC LED: Blue) 
Condition Conditions LED status 

No VCC No power supply Lights out 

VCC present 

Power supply from target system Lighting 

5V supply from EFP-LC2 Flashing(125ms) 

3.3V supply from EFP-LC2 Flashing(250ms) 

 

  



EFP-LC2 User's Manual  
 

Rev.1.04 2026/04 Page 11 / 41 

    

 

1.6 Names of EFP-LC2 
 

 

 
 

Figure 1.3 EFP-LC2 Part names 

 

Table 1.5 List of names of each part 
 name classification explanation 

1 ERR LED (red) Lights up and flashes in case of error 

2 RUN LED (Yellow) 
It lights up and flashes depending on PBT execution and when erasing data in the EFP-

LC2. 

3 STATUS LED (green) 
It lights up and flashes depending on the type of error and the state such as waiting for 

input 

4 VCC LED (blue) Target system power state (Reference Table 1.4) 

5 START switch 
PBT run (Reference 3.2 Section) and to erase data in the EFP-LC2  

(Reference 5 Section) 

6 USB I/F    (CN3) 
I/F 

Connect to the host machine with a USB Type-C cable (Reference 1.4 Section) 

7 TARGET I/F (CN5) Connect the cable to the target system (Reference Table 1.6) 

 * Detailed LED specifications other than [VCC] LEDs are 1.5 Section. 

 

1

2

15

16

 
Figure 1.4 Connector pinout diagram for connecting to the target system 

 

Table 1.6 Connector for connecting to the target system (CN5) 
 Signal Name I/o explanation 

1 GND - Circuit GND 

2 PC+ input External Start Optocoupler: TLP291 Input (Positive Voltage) 

3 (NC) - Unused 

4 T_VDD output Target System Power Input/Output 

5 PC- input External Start Optocoupler: TLP291 Input (Negative Voltage) 

6 Err output PBT file execution result signal (Reference 1.7 Section) 

7 Exec output PBT file execution status signal (Reference 1.7 Section) 

8 (NC) - Unused 

9 T_SCLK output Synchronous communication clocks for target microcomputers 

10 T_TXD output Serial transmission data for target microcomputer 

11 T_RXD input Serial Reception Data for Target microcomputer 

12 (NC) - Unused 

13 Start input External start signal (Reference 1.7 Section) 

14 T_RESET output Target microcomputer Reset Control Signal 

15 (NC) - Unused 

16 GND  Circuit GND 

 *For information on how to connect to the target system, refer to the separate instruction manual for your microcomputer family.  

1 

2 

3 

4 

5 

6 

7 
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1.7 EFP-LC2 External Control Signal 
The EFP-LC2 has control signals on the target system connector (CN5), and these signals can be used to control the writing 

operation from outside. Figure 1.5 shows an example of connecting an external control signal. 

 

⚫ CN5-13 (Start), CN5-2 (PC+), and CN5-5 (PC-) can be used as external start signals. 

Please select one depending on the circuit configuration of your target system. 

 

GND

PC+

1

2

PC-

Error

5

6

7
Execute

Start
13

16
GND

User's system

CN5

3.3[V]

TLP291
Internal Circuit

3.3[V]

1
0
K
[
Ω

]

Internal Circuit

LC2 internal circuit

10[Ω]
T_Reset

DTC143ZE

OUTIN

Reset
Circuit

14

To Target MCU

External Control Circuit

Internal Circuit

Internal Circuit

220[Ω]

3.3[V]

1
0
K
[
Ω

]

3.3[V]

3.3[V]

220[Ω]

Internal Circuit

3.3[V]

3.3[V]

220[Ω]

1.5K[Ω]

 
Figure 1.5 Example of external control signal connection 

 

CAUTIONS 

* The signals in the EFP-LC2 are internally pulled up to 3.3V as shown above. 

When pulling up on the target system, use a voltage of 3.3V or less. 

The EFP-LC2 may be damaged if connected to a target system that is pulled up to a voltage exceeding 3.3V. 

* Make sure that the current between CN5-2 (PC+) and CN5-5 (PC-) of the EFP-LC2 does not exceed the rated value of the 

TLP291 in the EFP-LC2 internal circuit. 

* Please note that the terminal specifications of CN5-2 (PC+) and CN5-5 (PC-) may differ when replacing another product made by 

Suisei Electronics Systems. 

* The RESET output of the EFP-LC2 is an open collector. 

If the RESET circuit has an open collector output, connect the RESET terminal with a 1kΩ pull-up. 

If the RESET circuit has a CMOS output, either disconnect it with a jumper, or connect the T_RESET signal on the EFP-LC2 side 

to the input of the RESET circuit. 

* The CN5-6 (Error) and CN5-7 (Execute) pins of the EFP-LC2 are CMOS outputs with a maximum rated output current of 7.6 mA. 

When connecting external circuits, ensure that the current does not exceed the rated value. 
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Figure 1.6 shows the timing chart after the [START] switch or an external start signal (CN5-13 (Start), or CN5-2 (PC+), CN5-5 

(PC-)) has been turned ON once after power-on. 

 

<Normal end> 

Running

  2nd Start Input  1st Start Input   3rd Start Input

Running(Next)

Start(In)

Execute(Out)

Error(Out)

CN5-6

CN5-7

CN5-13

Standby Running Completed Standby Running

Successfully

Completed

PBT Execution Status

 

<When an error occurs (recovery from an error by starting)> 

Recovering from an error

Error
Error(Out)

CN5-6

PBT Execution Status

Standby Running Completed Standby Running

Running

  2nd Start Input  1st Start Input   3rd Start Input

Running(Next)

Start(In)

Execute(Out)

CN5-7

CN5-13

Completed

 

Figure 1.6 External control signal sequence when CN5-13 (Start) is ON 

  



EFP-LC2 User's Manual  
 

Rev.1.04 2026/04 Page 14 / 41 

    

 

2. Control Software Installation 
LC2-Download Manager is an application that operates on the EFP-LC2. 

At startup, the latest version information is obtained via the Internet and the presence of an updater is checked. 

 

2.1 Control Software Installation Instructions 
Follow the steps below to install the control software LC2-Download Manager for the operation of the EFP-LC2. 

⚫ Install the software with an account that has administrator privileges.  

 

(1)When you run "setup.exe", the following screen will be displayed, so click the "Next" button. 

 

 
Figure 2.1 Setup screen (1/4) 

 

 

(2)The following installation folder input screen will be displayed. If you want to select a folder that is different from the screen 

notation, click Browse and select the folder according to the screen. With the destination folder indicated, click Next. 

 

⚫ When "Just me" is selected, only the user who installed the installation is registered, and 

 when "Everyone" is selected, all users are registered.  

 

 
Figure 2.2 Setup screen (2/4) 
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(3)The installation start screen appears. Confirm the displayed contents and click Next. 

 

 

 
Figure 2.3 Setup screen (3/4) 

 

(4)The User Account Control screen may appear.  

 If you select "Yes", a progress bar will be displayed and the installation will begin.  

 

 
Figure 2.4 Setup screen (4/4) 

 

(5)The installation completion screen is displayed. Select Close to exit the installer. 

 

 

2.2 Control Software Uninstall Instructions 
To uninstall the control software, follow the steps below. 

 

I. Select Settings from the Start menu and select "Apps" → Installed apps. 

II. From the list of installed applications, click "..." to the right of "LC2-Download Manager" and select "Uninstall".  

III. Please wait for the control software to be uninstalled.  

*Figure 2.4 Screen may be displayed. 

IV. Make sure that "LC2-Download Manager" does not appear in the list of applications.  
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3. Basic Operation 

3.1 Downloading data to EFP-LC2 
After the installation is complete, the procedure from creating a user program to downloading it to EFP-LC2 is shown below. 

 
procedure Operation/Settings References 

1 - Creation of user programs (HEX/MOT) 

* Create a program file with a compiler 
- 

2 - Create projects with control software 

1) Project name/target microcomputer setting 

2) Program Files 

3) Create a PBT file with the [Quick Creation] function 

(You can also register a PBT file that has already been created by you by clicking the [Reference] 

button.) 

* Set by control software 

4.1 

3 - Connection of the host machine, EFP-LC2, and target system 

・Power on 
1.4 

4 - COM port settings between the host machine and the EFP-LC2 

* Set by control software 
4.2.5 

5 - Download PBT/program files to EFP-LC2 

* Controlled by control software 
4.10 

 

IMPORTANT 

* Be careful not to unplug the USB cable while the EFP-LC2 and the control software are communicating.  

* When connecting via USB via a USB hub, it is recommended to use a self-powered USB hub. 

* In the event of instability in operation due to insufficient voltage, supply power from the target system. 

 

 

 

3.2 PBT file execution (writing to the target microcomputer, etc.) 
When the program files and PBT files have been downloaded to the EFP-LC2 (PBT ready to run), the  

[STATUS] LED on the EFP-LC2 flashes slowly. In that state, execute the PBT file by one of the following methods.  

 

(1)[START] switch ON on the EFP-LC2 

* At this time, stand-alone operation (not connected to the host machine) is possible. 

Power must be supplied from the EFP-LC2 or the target system via a USB cable. 

(2)In the control software, click the PBT Run button (Reference 4.10.2 Section) 

(3)Start signal input  CN5-13(Start)、CN5-2(PC+)/CN5-5(PC-) (Reference 1.7 Section) 

(4)Direct control from a PC via a Windows virtual COM port. 

* By using communication commands, you can operate the system from your application. 

If you would like the EFP-LC2 communication protocol specification, please contact us via the inquiry page (suisei-

support.x2@suisei.co.jp). 

 

I. The [RUN] LED on the EFP-LC2 will light up while the PBT file is running, and a "beep" buzzer will sound every time the 

command is executed. 

* The buzzer sound during command execution can be turned off (Reference 4.7 Section). 

II. When the execution of the PBT file is completed, the LEDs of the EFP-LC2 are as follows.(Reference Table 1.3) 

A) Normal   [ERR] LED: Off, [RUN] LED: Blinking*1, [STATUS] LED: Blinking*1  

B) In case of abnormality  [ERR] LED: Blinking or solid, [RUN] LED: Blinking*1, [STATUS] LED: Blinking*1 

*1 (RUN (yellow) and STATUS (green) flash alternately at 250[ms] intervals) 
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4. Control Software Details 
Select "LC2-Download Manager" from the Windows Start menu to start the control software and display the following screen.  

 
  

 
 

Figure 4.1 Main screen immediately after installation 

 

 Layout of the main screen 

A) Menu bar (top view) Displaying Software Names and Versions 

B) toolbar   4.1 Section 

C) Project Information 4.2 Section 

D) Operation related  4.10 Section 

E) Log information  4.11 Section 

F) Editing/Locked  4.12 Section 

 

 

  

A B 

C 

D 

E 

F 
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4.1 Toolbar 
4.1.1 File Menu 

When you click on the File menu, you will see a menu similar to the following: 

The File menu performs file-related operations. 

 

(1)Create a new project (N) 

Create a new project (Reference 4.2 Section). 

 

(2)Saving a Project(S) 

Saves the project you are currently working on. 

 

(3)Opening a Project(O) 

Open an existing project file. 

 

(4)EFP internal data upload(U) 

Upload each file in the EFP-LC2 to the host machine and save it as a file. For more information, see 4.4 Section 

 

(5)File Checksum calculation(C) 

Calculates the checksum of the program file. For more information, see 4.5 Section 

 

(6)Project History 

View the five most recent saved projects and select them to open them. 

 

(7)Exit (X) 

Close the app. 

 
 

 
 

Figure 4.2 File menu example 
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4.1.2 Settings menu 

When you click on the Settings menu, you will see a menu like this: 

 

(1)EFP Secure Settings(S)  4.6 Section 

(2)EFP Buzzer Settings(B)  4.7 Section 

(3)Update Check Settings(A)  4.8 Section 

 
 

 
 

Figure 4.3 Settings menu 

 

 

4.1.3 Help Menu 

In the Help menu, you will see a menu similar to the following: 

 

(1)Software Updates(L) 

If a new version of LC2-Download Manager is available, it will update. 

⚫ Only when updates are disabled (Reference 4.8 Section) 

The latest version information will be obtained via the Internet and a check will be made to see if an update is available. 

⚫ The installer will download and the installer setup will begin (if a new version is available). 

 

(2)EFP Firmware Update(F) 

Update the firmware of the EFP-LC2. For more information, Reference 4.9 Section. 

 

(3)Suisei Electronics System Home Page(S) 

The homepage of SUISEI Electronics System will open in your default browser. 

 
 

 
 

Figure 4.4 Help Menu 
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4.2 Create a new project 
To create a project, follow the steps below. 

When the control software starts, the previously saved project file is read (when the project has been saved). 

 

I. [Project Name] setting  Enter the name of the project in the Project Name field. 

II. [Target microcomputer] setting Set the Target microcomputer. 

III. [Program Files] Registration  Register the [Program Files] to be downloaded to the EFP-LC2. 

IV. Register [PBT File]  Register the [PBT File] to be downloaded to the EFP-LC2. 

 

[Project Name] Setting

[Target microcomputer] Setting

[Program Files]Registration

[PBT File]Registration
 

4.2.1 Section 

 

 

 

4.2.2 Section 

 

 

4.2.3 Section 

 

 

 

4.2.4 Section 

Figure 4.5 To create a new project 

 

 

4.2.1 [Project Name] 

Enter the [Project Name] to be created. 

 

IMPORTANT 

* Since the project name is used for the file name, characters that cannot be used in the file name cannot be used.  

* The file name can be up to 183 characters (including extensions) and up to 247 characters including the path. 

* This application cannot save files directly under the C: drive or in Windows system folders (Program Files, Windows, System32, 

etc.). Please use a folder under your user folder (Desktop, Documents, etc.) as the save destination. 

 

 

 

4.2.2 [Target microcomputer] Setting 

Select [Family Name]→, [Group Name]→ [Microcomputer name] according to the [Target microcomputer] to be used. 

The selected [Target microcomputer] information is used when checking program file registration and creating a PBT file. 

 

(1)Family Name 

⚫ By selecting [Family Name], you can select [Group Name].  

In addition, the contents of Supported Programmers will be updated.  

 

(2)Group Name 

⚫ By selecting [Group Name], you can select [Microcomputer name]. 

 

(3)Microcomputer name 

⚫ The selectable model name is the model name excluding package information/operating ambient temperature, etc. 

For microcomputers that have package information in the middle of the model name, the corresponding part will be "x" 

(e.g. R5F104xF) 

 

 

4.2.3 [Program Files] Registration 

Register the [Program Files] to be downloaded to the EFP-LC2. 

⚫ Files can be registered after selecting the [Microcomputer name]. 

⚫ Up to 6 program files can be registered. 

⚫ Files that can be registered are in mot/hex/hxw format. *See section 1.3.1 for usable files. 
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4.2.3.1 Procedure for registering program files 

I. Click the [Registration]  button and specify the program file to be registered.  

II. The program file registration screen is displayed (Reference Figure 4.6). 

 

 
Figure 4.6 Program file registration screen 

 

III. If the specified program file consists of multiple resources such as Code Flash and Data Flash, the area setting radio button will 

be enabled. 

When [Registration]  is executed, the program file information is registered in the address range of [Area Setting] entered.  

IV. Any parts of the selected file outside the range will be filled in with the entered [Data Completion Value]. 

Program File  Setting Address  

Example 1: C000h-FFFFh B000h-FFFFh => B000h-BFFFh is the data completion value 

          C000h-FFFFh is the value of the program file. 

Example 2: C000h-FFFFh D000h-FFFFh => D000h-FFFFh is the value of the program file 

Example 3: C000h-FFFFh 8000h-BFFFh => 8000h-BFFFh is the data completion value 

V. If there is no mistake in the specified contents, click the [Registration]  button. 

VI. The registered file name is displayed in the target file field on the main screen. 

 

IMPORTANT 

*Program file registration unit 

- If a program file other than the selected microcomputer resource is selected, an error will occur. 

- For program files that consist of multiple resources such as Code Flash and Data Flash, select Code Flash, Data Flash, or User 

Boot using the radio buttons. For areas not selected using the radio buttons, please register them separately. (For example, if 

you have registered Code Flash data in File 1, please register Data Flash data in File 2, etc.) 

 

* Registration unit of the program file 

- The minimum unit for registering a program file on the EFP-LC2 varies depending on the selected MCU. 

:RX: 256 bytes 

:RL78 Family (Protocol A or C): Blocks 

:RL78 Family (Protocol B): Entire Code Flash or Data Flash area 

- If the minimum unit is not met at the time of registration, or if there is no data in the area, it will be automatically 

supplemented with [Data Complement Value] and registered. 

e.g. Specified program file C010h-DFF0h 

→ At the time of registration C000-DFFFh *C000h-C00Fh and DFF1h-DFFFh are [data Completion values] 

* [Specify the Area] Address Range 

- If the program file is an hxw file, the [Specify the Area] address range cannot be changed. 

- For the RL78 Family (Protocol B), the [Specify the Area] address range cannot be changed. 

- An error will occur if an address range outside the selected MCU resource is specified. 

 

* Precautions when using the PBT quick creation function 

- When registering multiple files, the area of the program file registered earlier and the area of the program file to be added are 

duplicated.Files cannot be registered. 

- If you create/register a PBT file using the PBT quick creation function and then add/remove a program file, the PBT file will be 

unregistered. 
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* Restrictions for the RL78 family 

- For the RL78 family (Protocol A or C), programs are executed in block units, so an error will occur if the [Specify the Area] 

address range is not set in block units. 

In that case, set the [Specify the Area] address range so that it is set in block units. 

- For the RL78 family (Protocol B), programs are executed in the entire Code Flash or Data Flash area, so an error will occur if 

the [Specify the Area] address range does not specify the entire area. 
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4.2.3.2 Unregistering Program Files 

You can cancel a registered program file by following the steps below. 

I. Click the [Release] button of the target file. 

II. A confirmation message will appear asking if you want to unregister the file. Click the [OK] button to unregister it. 

 

IMPORTANT 

* If you create/register a PBT file using the PBT quick creation function and then add/remove a program file, the PBT file will be 

unregistered. 

 

 

4.2.3.3 Show details 

Click the [Show details] button Figure 4.7 form opens, displaying information about the registered program files. 

 
 

 
 

Figure 4.7 Detailed display 

 

IMPORTANT 

* Notes on CRC Sum Value 

  The CRC sum value is calculated in 4-byte units. 

  If the data is less than 4 bytes, the data is completioned with the "Data Completion Value" before the sum value is calculated. 

 

 

4.2.4 Register [PBT File] 

Register the PBT file (script file) to be downloaded to the EFP-LC2. 

Files can be created/registered using files created for existing models such as EFP-LC, or using the PBT quick creation function of 

LC2-Download Manager. For details on [Quick Creation], Reference 4.3 Section. 

⚫ Files can be registered/created after selecting [Microcomputer name]. 

 

(1)Selecting a pre-created PBT file 

⚫ A created PBT file can be registered by clicking the [Reference] button and selecting the target file. 

⚫ The [Baud-rate set] command (S or N) for EFP-LC, etc. cannot be used with EFP-LC2, so an error will be displayed. 

 

(2)Create and select a PBT file in [Quick Creation] 

⚫ When creating/registering a PBT file, click the [Quick Create] button. 

* For details, refer to section 4.3 or the separate instruction manual for each microcomputer family. 

 

(3)Unregistering the PBT file 

⚫ Clear with the [Release] button. 

 

IMPORTANT 

* If a created PBT file is selected, the PBT quick creation function cannot be used. 
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4.2.5 [EFP Connection Settings] 

Follow the steps below to register the COM port when connecting the host machine to the EFP-LC2. 

I. Click the [Settings] button on the main screen to display the EFP connection settings screen (Reference Figure 4.8). 

II. The COM port of the EFP-LC2 connected to the host machine is displayed as a selection from the pull-down menu, so 

 select the COM port of the EFP-LC2 to be connected.  

III. Click the "OK" button to return to the main screen, and the selected COM port is displayed in [Serial No (COM Port)], and 

 the firmware version of the EFP-LC2 connected to [Firmware Version] is displayed.  

* The selected content will be saved in the project file when the project is saved. 

 

 

Figure 4.8 COM port selection screen 
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4.3 Quick Creation PBT 
You can easily create a PBT file by simply checking or entering information in each item. 

After completing the necessary settings, click the [Create] button to create a [PBT File]. 

* This application cannot save files directly under the C: drive or in Windows system folders (Program Files, Windows, System32,  

etc.). Please use a folder under your user folder (Desktop, Documents, etc.) as the save destination. 

* Some items will be hidden/disabled depending on the selected target microcomputer. 

* This manual describes items that are common to all target microcomputers. 

For microcomputer family-specific settings and whether each command can be created on the target microcomputer, please refer 

to the separate instruction manual for each microcomputer family. 

⚫ Basic Setting Tab 4.3.1 Section 

⚫ Memory Map Tab 4.3.2 Section 

⚫ Security Tab 4.3.3 Section 

⚫ Option Tab 4.3.4 Section 

⚫ EFP Tab  4.3.5 Section 

 

 
Figure 4.9 Basic Setting Tab 

 

 

4.3.1 Basic Settings Tab 

This tab is a setting for generating commands for programming operations such as [Blank], [Erase], [Program], and [Read] for the 

target microcomputer. 

 

4.3.1.1 [Blank check] 

⚫ When this checkbox is checked ON, a [Blank] command will be generated for the areas that are checked ON for the target 

block in the [Blank] column on the [Memory Map] tab. 

⚫ If you want to generate a [Blank] command for the entire area of the target MCU resources, check [All Areas]. 

 

4.3.1.2 [Erase] 

⚫ When this checkbox is checked ON, an [Erase] command will be generated for the area that is checked ON for the target 

block in the [Erase] column of the [Memory Map] tab. 

⚫ To generate an [Erase] command for the entire area of the target MCU resources, check [Erase All Areas]. 

 

4.3.1.3 [Program] 

⚫ When this checkbox is checked, [Program] commands will be generated for all registered program files. 

 

4.3.1.4 [Verify] 

⚫ When this checkbox is checked, a [Verify] command will be generated for all registered program files. 

 

4.3.1.5 [Checksum] 

⚫ When this checkbox is checked, a [Check sum] command is generated for all registered program files. 

 

4.3.1.6 [Read] 

⚫ When this checkbox is checked, a [Read] command is generated to create a file in the range specified by the specified file 

name.  
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4.3.2 Memory Map Tab 

In this tab, you can set the target area when generating the [Blank], [Erase], and [Lock bit] commands for the target 

microcomputer. 

 

 < Block List> 

⚫ Blocks for each resource (Code Flash/Data Flash/User Boot) of the selected target microcomputer are displayed on the left 

side.  

 

 < View Details> 

⚫ Start:  Indicates the starting address of the target block (the first line is the target resource). 

⚫ End:  Indicates the end address of the target block (the first line is the target resource). 

⚫ Size:  Indicates the size of the target block (the first line is the target resource). 

⚫ Blank:  Check the block to be the target of the [Blank] command. 

⚫ Erase:  Check the block to be the target of the [Erase] command. 

⚫ Lockbit: Check the block to be the target of the [Lock bit] command. 

 

< Detail Display: Default > 

 
< hide details> 

 
Figure 4.10 Memory Map Tab 

 

  



EFP-LC2 User's Manual  
 

Rev.1.04 2026/04 Page 27 / 41 

    

 

4.3.3 Security Tab 

In this tab, you can configure the settings for generating security-related commands such as [ID-collation], [Security Set], and 

[Signature] for the target microcomputer. 

 

 
Figure 4.11 Security Tab 

 

4.3.3.1 [ID Verification] 

⚫ By checking it, the [ID Verification] command is generated. 

⚫ The display content differs depending on the selected target microcomputer. 

 

(1)Format 

⚫ "ASCII" or "HEX" can be selected.  

 

(2)ID Code 

⚫ Enter the ID code that is set on the target microcomputer or the ID code that you want to set. 

⚫ "ASCII" or "HEX" can be selected.  

 

IMPORTANT 

*ID Verification 

- The ID verification function differs depending on the selected target microcomputer, so please refer to the separate instruction manual 

for each microcomputer family. 

 

 

4.3.4 [Option] Tab 

Use this tab to configure the [Option] command generation settings for the target microcomputer. 

Each setting is enabled by turning on the [Optional Commands] check box. 

 

 
Figure 4.12 Options tab  
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4.3.5 [EFP] 

In this tab, you can generate commands such as the [VDD supply] command, the [Baud-rate set] command, and the [Mode entry] 

command for the target microcomputer before executing the EFP-LC2 programming operation command. 

 

 
Figure 4.13 EFP Tab 

 

4.3.5.1 [Power supply to the MCU] 

Create a [VDD supply] command to indicate whether or not the EFP-LC2 can supply power to the target system. 

When supplying power to the target system from an external power supply, there is no need to select (default = Target Supply). 

In this case, you do not create a [VDD Supply] command. 

 

 

IMPORTANT 

* When using this command, do not supply power from the target system to the target microcomputer. 

When using this command, if the power supply voltage (T_VDD terminal) on the target system is detected to be +2 [V] or higher, the 

EFP-LC2 will not supply (output) power to prevent a power supply collision. 

 

 

 

4.3.5.2 [Communication speed with MCU] 

Generate the [Baud-rate Set] command, which is the communication speed setting between the target microcomputer and the 

EFP-LC2. 

 

IMPORTANT 

* Communication speed with MCU 

- The communication speed that can be set varies depending on the target microcomputer, so please refer to the separate instruction 

manual for each microcomputer family. 

- Communication may not be possible even at a selectable communication speed. In this case, set the communication speed to a lower 

speed. 
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4.4 EFP Internal data upload 
Upload each file in the EFP-LC2 to the host machine and save it as a file. 

 

I. Select [EFP Internal data upload] from the File menu to read all file information in the EFP-LC2.  

II. Figure 4.14 form opens and displays the retrieved file information. 

* If the target file is not available on the connected EFP-LC2, it will be blank and the upload selection will be invalid. 

* In a state where there is a security restriction (Reference 4.6 Section), the Upload Select is disabled. 

 

 
Figure 4.14 EFP Internal Data Upload 

 

(1)Storage Folder 

⚫ Specify the destination folder for the uploaded file. 

* This application cannot save files directly under the C: drive or in Windows system folders (Program Files, Windows, 

System32, etc.). Please use a folder under your user folder (Desktop, Documents, etc.) as the save destination. 

 

(2)Log files 

⚫ The log file is created when PBT is executed on the connected EFP-LC2. 

⚫ The following information can be confirmed in the log file (RESULT.TXT). Figure 4.16 shows a sample. 

・ Script command execution result 

・ firmware version 

・ PBT file execution result and error count 

・ number of program files and PBT file downloads 

・ program file name in EFP-LC2 

・ EFP-LC2 status information 

 

(3)Data files 

⚫ You can select the save format for program files, MOT/HEX/HXW. 

⚫ Read data is created by executing the [Read] command in PBT execution.  



EFP-LC2 User's Manual  
 

Rev.1.04 2026/04 Page 30 / 41 

    

 

 

4.4.1 File Upload Procedure 

I. Connect the EFP-LC2 to the host machine and select the connected EFP-LC2 in [EFP Connection Settings] (Reference 4.2.5 

Section). 

II. From the File menu, select [EFP Internal data upload]. 

III. Select the file you want to upload. 

IV. For the data file (Program Files/Data Files), select the format in which you want to save them. 

V. Click the [Upload] button to start uploading the file. 

VI. When the buzzer sound "beep" sounds, the upload is complete.  

* It will continue until all selected files are uploaded. 

VII. The read file will have the following file name to distinguish it from the downloaded file.  

・ The exported file format and the selected file format are the same: Up + Exported file name 

Example: RX_DF_1K_0x00100000.mot → Up_RX_DF_1K_0x00100000.mot  

・ The file format you read and the selected file format are different: Up + Add the extension of the exported file name to 

the end 

Example: RX_DF_1K_0x00100000.mot → Up_RX_DF_1K_0x00100000_mot.hxw 

 

 

 
Figure 4.15 EFP Internal Data Upload Procedure 

 

IMPORTANT 

* If there is a file in the folder that is the same as the file that was read, it will be overwritten. 

* Even if the downloaded file and the uploaded file have the same file format, they may not match due to [Data Completion 

Value] and [Specify the Area]. 

* Do not execute PBT with the button on the EFP-LC2 main unit while uploading a file. 

  

Ⅲ 

Ⅳ 

Ⅴ 



EFP-LC2 User's Manual  
 

Rev.1.04 2026/04 Page 31 / 41 

    

 
Log result Explanation 

RX630_test.pbt 

[TRACE START]  

1:<t=38> 

RX LittleEndian 

T command OK. 

Time = 0.000sec. 

2:<x=2> 

MCU VDD(+3.3V) on. 

X command OK. 

Time = 0.009sec. 

3:<s2=6> 

Set 500000Bps! 

S command OK. 

Time = 0.000sec. 

4:<m,800,8,4> 

Set MCU Config. 

M command OK. 

Time = 3.609sec. 

5:<i,1,FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF,1> 

Set to MCU ID. 

I command OK. 

Time = 0.000sec. 

6:<e,,1> 

MCU erasing now. 

E command OK. 

Time = 0.697sec. 

8:<p,Data32k.hxw,00100000,00107FFF,1> 

Data programing now. 

Check SUM=003FF1AB 

P command OK. 

Time = 3.485sec. 

9:<v,Data32k.hxw,00100000,00107FFF> 

Data verifying now. 

Check SUM=003FF1AB 

V command OK. 

Time = 0.724sec. 

 

[TRACE END] 

 

Execution result of PBT command 

--Machine Report -- 

EFP-LC2 Ver.1.03.00 

Type-RX 32MB 

[Firmware] 

DATE: 2026/01/06 

EFP-LC2 unit information 

[Counter] 

PBT executed:    3 

Error occurred:    3 

Total executed:  24 

 

Number of PBT file executions (including the 

number of times an error occurred) *1*2 

Number of errors*1*2 

The number of times the PBT file is 

executed and Number of Errors 

*1 Reset with PBT file download 

[Download count] 

PBT file   21 

PRG file   15 

 

Number of PBT File Downloads *2 

Number of Program File Downloads*2 

*2 The maximum value of the counter is 65535. After that, it will restart counting from 0. 

(The counter will be reset to 0 on the 65536th execution.) 

[PRG file] 

1: RX_CF_1K_0xFFFF0000.mot 

2: RX_CF_1K_0xFFFF0400.mot 

3: RX_CF_1K_0xFFFF0800.mot 

4: RX_CF_1K_0xFFFF0C00.mot 

5: Data32k.hxw 

6: * 

 

[PBT file] 

  1: RX630_test.pbt 

 

[Read file] 

1: RX630_READ.hxw 

[PRG file] 

mot/hex/hxw: Program Files File Name 

 

 

 

 

 

 

[PBT file] 

PBT: PBT file name 

 

[Read file] 

hxw: File name output by the [Read] command 

In EFP-LC2 

Files that are being downloaded 

(*: Undownloaded space) 

Figure 4.16 Sample log file (RESULT.TXT) (Some notations may differ depending on the firmware version) 
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4.5 File Checksum ｃalculation 
Calculates the checksum of the program file. 

When you select [File Checksum Calculation (C)] from the file menu, Figure 4.17 form opens. 

 

I. Use the [Reference] button to select the program file to be checksummed.  

* The start/end address of the selected program file is displayed in the area settings.  

II. When changing the area to be calculated, check [Specify area] and update the area setting of the start/end address. 

III. Use the [Calculation] button to calculate the checksum.  

Add: The 4-byte checksum value added byte by byte 

Sub: The 4-byte checksum value minus bytes 

CRC: CRC sum value calculated from the most significant byte in 4-byte units 

 

 
Figure 4.17 Checksum calculation 

 

 

IMPORTANT 

* If it is outside the range of the program file, the value of [Data Completion Value] is set. 

* The CRC sum value is calculated in 4-byte units. 

  If the data is less than 4 bytes, the data is completioned with the "Data Completion Value" before the sum value is calculated. 
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4.6 EFP Secure Settings 
Configure the secure settings for the EFP-LC2 and prohibit internal data uploads of the EFP-LC2. 

Table 4.1 describes the secure status of each setting. 

 

(1)Download/upload prohibition function 

⚫ Secure ID settings prohibit downloads and internal data uploads to the EFP-LC2. 

It also prohibits firmware updates. 

 

(2)PBT execution limit function 

⚫ When PBT execution completes normal writing the number of times set in [Number of executions], the data in the EFP-LC2 is 

erased at the next execution and further writing is prohibited. 

 

 
Figure 4.18 EFP Secure Settings 

 

⚫ Security Level:  Select the level of security you want to restrict 

⚫ Secure ID:  Set the ID for security settings (also required for unlocking). 

4-digit alphanumeric characters (uppercase and lowercase letters are sensitive) 

⚫ Execution Count: Set the maximum number of PBT executions in the range of 1-50,000. 

 

Table 4.1 Functional restrictions by Secure Level 

function 
Security Levels 

Level0 (No Security) Level1 Level2 

Upload PBT file (*.pbt) Yes No No 

Program File 

(*.mot/*.hex/*.hxw) 

Yes No No 

Log File 

(RESULT.TXT) 

Yes Yes 
Yes 

Download PBT file (*.pbt) Yes Yes No 

Program File 

(*.mot/*.hex/*.hxw) 

Yes Yes No 

Firmware version update Yes No No 

Execution Limit Not configurable Not configurable Configurable 

E
xe

c
u
tion

 R
esult L

o
g 

Example of security level display 

-- Machine report -- 

EFP-LC2 Ver.1.00.00 

Type-RX 32MB 

-- Machine report -- 

EFP-LC2 Ver.1.00.00 

Type-RX 32MB  

Security level 1 

-- Machine report -- 

EFP-LC2 Ver.1.00.00 

Type-RX 32MB  

Security level 2 

Example of execution count counter display 

[Counter]  

PBT executed:    3 

Error occurred:   0 

Total executed:   3 

[Counter]  

PBT executed:    3 

Error occurred:   0 

Total executed:   3 

[Counter] 

PBT remains:     9 

PBT executed:    1 

Error occurred:   0 

Total executed:   3 
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4.6.1 Secure Configuration Procedure 

I. Connect the EFP-LC2 to the host machine and select the connected EFP-LC2 in [EFP Connection Settings] (Reference 4.2.5 

Section). 

II. Select [EFP Secure Settings] from the settings menu. 

III. Select the security level you want to set. 

IV. Set an arbitrary ID code (up to 4 single-byte alphanumeric characters) in the [Secure ID] field. 

* For EFP-LC2 with an ID code set, when updating to Security Level 0 or updating the number of executions, 

You will need to enter the ID code that has been set. 

* "0", "00", "000", "" 0000" is invalid and will result in an error.  

* Please note that the English characters that can be used for Secure ID are case-sensitive, so please be careful when setting. 

V. When Security Level 2 is selected, enter the number of executions (1-50,000) in the [Execution Count] column. 

* The maximum value of [Execution Count] is 50,000. 

VI. Click the [Setting] button.  

VII. The secure configuration information is transferred to the EFP-LC2. 

An example of a buzzer when set from Security Level 0 is as follows. 

When changing from another security level, the buzzer will be different. 

A) Security Level0 A "Beep-beep" buzzer will sound and the settings are complete. 

B) Security Level1 A "Beep-beep" buzzer will sound and the settings are complete. 

C) Security Level2 A "Beep-beep-beep" buzzer will sound and the settings are complete. 

 

 
Figure 4.19 EFP Secure Configuration Procedure 

 

(1)About the number of executions at Security Level 2 

⚫ After the set number of writes has been completed, a warning sound will be emitted the next time you execute PBT or upload 

the log file (RESULT.TXT). 

If you execute PBT again while the warning sound is being emitted, the LED will flash and the internal data of the EFP-LC2 

will be erased, preventing any further writing. 

⚫ The warning sound will not be canceled until you press the [START] switch on the EFP-LC2. 

⚫ Do not turn off the power while erasing data. If the power is turned off during erasing, data cannot be restored. 

⚫ After erasing data, the [STATUS] LED on the EFP-LC2 will light up and the security settings will be disabled. 

⚫ The log file (RESULT.TXT) of the last execution result can only be uploaded for the first time while the warning sound is being 

generated or after data is deleted. 

 

(2)How to remove security 

⚫ If you set it to Security Level 2, you will not be able to download.  

Data changes in the EFP-LC2 require an update to Security Level 0.  

⚫ Please note that if you make a mistake in the ID code three times in a row, you will not be able to authenticate the ID code 

for the next 1 hour (leave the EFP-LC2 in the power ON state).  

Even if the ID is prohibited, it is possible to execute PBT files and upload execution result logs regardless of security settings. 

 

IMPORTANT 

* To set up security, you need to download the program file and PBT file.  

 If no files have been downloaded, no security features are configured.  

 

 

Ⅲ 

Ⅳ 

Ⅴ 

Ⅵ 
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4.7 EFP Buzzer Settings 
When PBT is executed, a buzzer sound is heard for each command, but this ON/OFF can be set. 

The operation when setting ON/OFF is as shown in the Table below. It cannot be turned off except when executing commands. 

 

Table 4.2 EFP-LC2 Buzzer Settings 

Buzzer setting 
PBT Execution LC2-Download Manager 

beginning Command Execution end Download Upload 

ON (default) Rings Rings Rings Rings Rings 

OFF Rings Does not ring Rings Rings Rings 

 

 
Figure 4.20 EFP Buzzer Settings 

 

I. Connect the EFP-LC2 to the host machine and select the connected EFP-LC2 in [EFP Connection Settings] (Reference 4.2.5 

Section). 

II. Select [EFP Buzzer Settings] from the settings menu. 

III. Check the [ON] or [OFF] checkbox, and then click the [Setting] button. 

IV. The information from the EFP buzzer is transferred to the EFP-LC2. 

V. Once the "beep" buzzer sounds, the settings are complete. 

 

IMPORTANT 

* When the [Settings] button is clicked without selecting the check box, an error message will be displayed. 

* If [Buzzer: OFF] is checked, the buzzer will not sound when the wait command is executed and while the buzzer is waiting for 

key input. 
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4.8 Update Confirmation Settings 
When the control software starts up, it obtains software update information (control software and EFP-LC2 firmware) via the 

Internet and checks for important or latest update files. 

It also displays a message. 

Here you can prohibit the acquisition of update information and set the display interval. 

 

 
Figure 4.21 Update Confirmation Settings 

 

(1)Don't check for updates at startup: 

⚫ OFF (default)  Update information will be obtained when the control software is started. 

⚫ ON   Prohibits obtaining update information. 

(2)Display Interval (1-60 days): 

When an important update is available but software update is not selected, set the period until the next message is displayed. 

 

IMPORTANT 

* When [Don't check for updates at startup] is ON, software update information will not be obtained. 

As a result, you will not be able to check whether there are any important updates. 

In this case, please check the software update information on our website to see if there are any important updates. 

* When software update is not selected, a message will not be displayed until the [Display interval] has elapsed, but if there is an 

important update, please update your software as soon as possible. 
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4.9 EFP Firmware Update 
The firmware of the EFP-LC2 can be updated. The procedure for rewriting the firmware in the EFP-LC2 is shown below.  

Update enabled (Reference 4.8 Section) and when the control software is started or [EFP connection settings] 

If there is an important update of F/W, you will be redirected to this screen. 

⚫ Please prepare a compatible type of firmware that is compatible with the EFP-LC2 you purchased. 

⚫ The corresponding type (Type-RX, etc.) is indicated on the surface of the EFP-LC2 housing. 

 

Table 4.3 EFP-LC2 Compliant Firmware(For Type-RX) 

type Compatible Firmware 

EFP-LC2 Type-RX EFP-LC2_Type-RX_Ver.x.xx.xx.fzw 

EFP-LC2 Type-RL78 EFP-LC2_Type-RL78_Ver.x.xx.xx.fzw 

x.xx.xx of the compatible firmware contains the firmware version. 

 

I. Connect the EFP-LC2 to the host machine and select the connected EFP-LC2 in [EFP Connection Settings] (see section 4.2.5 

for details). 

II. Select [EFP Firmware Update] from the Help menu. 

III. Register the firmware using one of the following methods. 

A) Click [Download from Web] to download from the network (when update is enabled: see section 4.8). 

B) Save the firmware obtained from our website or E-mail, etc., in the desired folder and click the [Reference] button to select 

the file. 

IV. Click the [Update] button to start the update.  

* The [RUN] and [STATUS] LEDs of the EFP-LC2 light up.  

V. When the download is complete, a "beep" buzzer will sound once and firmware rewriting will automatically begin. 

VI. After the firmware data has been rewritten, the buzzer will beep twice, the EFP-LC2 unit will restart, and the update will be 

complete. 

 

 
Figure 4.22 Firmware 

 

 

IMPORTANT 

* Program files and PBT files downloaded to the EFP-LC2 will be retained even after the firmware is rewritten. 

* The [RUN] LED and [STATUS] LED on the EFP-LC2 will flash while the firmware is being rewritten, so do not turn off the power at 

this time. 

If the power is turned off during rewriting, the EFP-LC2 will not start up and repair support will be required. 
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4.10 Operation-related 
4.10.1 Download 

Download the registered PBT/program file for the connected EFP-LC2.  

At the time of this operation, connect the EFP-LC2 to the host machine and specify the EFP-LC2 to be used in [EFP connection 

settings].  

 
 

 
 

Figure 4.1 Operation related 

 

4.10.1.1 Download Type 

(1)[ProgramFile/PBT] 

⚫ Download all registered program files and PBT files (default). 

⚫ This can only be selected when both the PBT file and the program file are registered. 

(2)[ProgramFile] 

⚫ Only all registered program files are downloaded. 

⚫ When only program files are registered, the selection is disabled in this display. 

(3)[PBT] 

⚫ Only registered PBT files are downloaded. 

⚫ When only PBT files are registered, the selection is disabled in this display. 

 

4.10.1.2 Download 

I. Click the [Download] button to download the target file selected by download type to the EFP-LC2. 

II. Files in [MOT/HEX] format are automatically converted to [HXW] format files when they are downloaded.  

* EFP-LC2 handles files in HXW format.  

III. The [RUN] LED on the EFP-LC2 lights up and the progress bar indicates the progress. 

IV. The download is complete when the buzzer beeps twice.*1.  

*1 The first buzzer sound is the sound when the data transfer is complete, and the second buzzer sound is the sound when it is 

confirmed that there is no abnormality in the file.  

V. When the download of both the program file and PBT is completed, the buzzer sound of the download is complete, followed by 

the buzzer sound of "bee", and the PBT is ready to run. 

The [STATUS] LED on the EFP-LC2 will flash slowly when it is ready to execute PBT. 

* After running PBT, if you have downloaded only the program file or the PBT file, press the [START] switch on the EFP-LC2. 

  If you run [PBT Execution] without pressing the [START] switch, an error message will appear prompting you to download the 

files that were not downloaded. 

 

IMPORTANT 

* When a program file is downloaded, the oldest area is erased first among the six areas in the EFP-LC2. 

 

 

4.10.2 PBT Execution 

Erasing, writing, etc. are performed by executing the PBT file downloaded to the EFP-LC2 to the target microcomputer. PBT file 

execution can be done via the control software or by pressing the EFP-LC2 main unit button (see section 3.2). At the time of this 

operation, connect the EFP-LC2 to the host machine and specify the EFP-LC2 to be used in [EFP connection settings]. 

 

4.10.2.1 [PBT Execution] 

Click the [PBT Execution] button to execute the command described in the PBT file for the EFP-LC2 connected to the host 

machine. 

⚫ An error occurs when PBT execution is not ready (both the program file and PBT file have been downloaded). 

At this time, the [STATUS] LED on the EFP-LC2 flashes slowly. 

⚫ While PBT is running, the [RUN] LED on the EFP-LC2 lights up, and a buzzer beeps each time a command is executed. 

When the script is executed successfully, the [ERR] LED on the EFP-LC2 will turn off, and when an error occurs*1, the LED 

will turn on or blink. 

*1 For information on how to deal with EFP-LC2 errors, see Chapter 6. 

 

4.10.2.2 [LOG display] 

The log file generated by [PBT Execution] can be displayed by clicking the [LOG display] button. 

* If PBT is not executed (log file is not created on EFP-LC2), an error will occur. 

* Log files can also be obtained using the upload function (see section 4.1.2).  
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4.11 Log Viewing 
4.11.1 Log output screen 

The status of the command issued to the EFP-LC2 and the result, as well as the contents of the error message, are displayed. 

 * It will be cleared with the [Clearing Status and Messages] button or cleared at the start of the download. 

 

4.11.2 [Clearing Status and Messages] 

Clear the log screen. 

 

 

4.12 Editing/Locked 
In order to prevent the created project from being updated by an unintentional mistake, disable the setting of the target item. 

⚫ Target: 

[Project Name], [Target microcomputer], [Registration] / [Release] button (file 1-6 registration), 

[Reference] / [Quick Creation] (PBT file) 

 

(1)Status: Editing 

You can edit each item while creating the project. 

 

(2)Status: Locked 

When saving a project or loading a project (including when launching the app), if the [Target microcomputer], [PBT File], and 

[Register program files 1 to 6]*1 have been set, the project will transition to a locked state. 

*1 One of the settings 
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5. Initialize the EFP-LC2 data 
The EFP-LC2 can be erased by following the steps below. 

 

I. Turn on the power while holding down the [START] switch on the EFP-LC2.  

[STATUS] LED on → [RUN] LED on 

II. Confirm that the buzzer sounds repeatedly (beep beep beep) and release the [START] switch to blink the [STATUS] LED 

III. [START] Press and hold the switch (for more than 2 seconds) to cause a buzzer to sound (beep beep) and automatically erase. 

During automatic erasure, the [RUN] LED will flash, and the [STATUS] and [ERR] LED will turn off. 

IV. When automatic erasure is complete, the [STATUS] LED will light up and the [RUN] LED and [ERR] LED will turn off. 

 

 

 

6. Troubleshooting 
When an error is detected, the error LED on the EFP-LC2 main unit lights up. Here are some of the errors that occur in EFP-LC2 and 

how to fix them 

.  

 If the problem persists after rechecking the connection or restarting the EFP-LC2, refer to FAQ (https://www.suisei.co.jp/qa/). If this 

does not solve the problem, please contact us or your distributor.  

For other questions, please contact us by E-mail (suisei-support.x2@suisei.co.jp).  

 

LED display 

Causes and remedies STATUS 

(Green) 

ERR 

(Red) 

Lighting Lighting 

<PBT execution error> 

⚫ The start/end address in the program file and the PBT file may be different.  

* Except for [Quick Creation] 

Flashing 

(250ms) 

Lighting 

 

< Target MCU-related errors> 

⚫ Is the power supply voltage of the target microcomputer being used within the normal range?  

(Refer to the hardware manual of the target microcomputer) 

⚫ Is there a mistake in the wiring between the target microcomputer and the EFP-LC2? 

(Refer to the separate instruction manual for each microcomputer family.) 

⚫ There is a possibility that the connector part of the EFP-LC2 is not in good contact or the target connection 

cable is damaged.  

Please review your connection. 

⚫ The communication baud rate may not match. 

Please review the settings, such as changing to a lower baud rate. 

⚫ Is there a mistake in the wiring between the target microcomputer and the EFP-LC2? 

(Refer to the separate instruction manual for each microcomputer family.) 

⚫ There is a possibility of poor contact between the EFP-LC2 connector and IC socket.  

Clean the connectors and IC sockets.  

⚫ Do you clear the data before executing the [Blank] command? 

If the lock bit is enabled and erased, erase it with the lock bit disabled. 

Flashing 

(250ms) 

Flashing 

(100ms) 

[Security Feature Setting/Cancellation Error] 

⚫ Have you entered an ID code that is different from the ID code set on the EFP-LC2? 

Please re-enter the correct ID code (Reference 4.6 Section). 
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Revision Records 
revision date Revision details 

Rev.1.00 2025/06 First edition. 

Rev.1.01 2025/08 1.3 Support for the RL78 family has begun. 

1.3 Added restrictions on characters that can be used in file names to [Important]. 

1.5 Changed the LED lighting state when PBT execution is completed (no errors). 

     Before change: "STATUS (green) LED" flashes quickly (125ms), "RUN (yellow) LED" is off. 

     After the change: The "STATUS (green) LED" and "RUN (yellow) LED" flash alternately (250ms). 

4.2.3.1 Added restrictions for the RL78 family to [IMPORTANT]. 

4.7 Added information about ON/OFF of buzzer sound when a wait command is issued. 

Rev.1.02 2025/09 4.2.3.1 The explanation of area settings has been revised in response to the fact that it is now possible to use files 

that span multiple areas when registering program files. 

4.2.3.1 Added Protocol B restrictions to the RL78 family restrictions in [IMPORTANT]. 

4.2.3.3 and 4.5 Added explanation on how to calculate the CRC sum value to [IMPORTANT]. 

4.5 Added explanation about the addition of CRC sum value to the file checksum calculation function. 

Rev.1.03 2026/02 Updated the execution result log sample to the format for Type-RX Ver.1.03.00 or later. 

Rev.1.04 2026/04 Please read this first 
 Added D) Communication Protocol Specification. 

1.3 Table 1.2 *3 R8C/14 to 1B have been excluded from the varieties planned to be compatible with R8C. 

1.5 Corrected an error in the LED display status in Table 1.3. 

1.6 Changed the descriptions of RUN in Table 1.5 and Error and Execute in Table 1.6. 

1.7 Changed Figure 1.5 Example of external control signal connection. 

1.7 Added notes for Error and Execute to [Notes]. 

1.7 Changed Figure 1.6 External control signal sequence when CN5-13 (Start) is ON. 

3.2 Added (4) Direct control from PC via Windows virtual COM port to PBT file execution. 

3.2 II Change the LED status when PBT execution is complete (when an error occurs). 

5 Added LED status. 

6 Changed LED display. 
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